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 Transferring Pictures  Slide Shows  Sorting Pictures

 Retouch  Retouch (NEF/RAW)  Editing Movies

 Printing Pictures  Web Services  E-Mail

A Save where otherwise stated, the illustrations in this manual show the software as it appears in Windows 7 at a display resolution of 1280 × 1024 (SXGA). Some portions of the windows and dialogs shown 

in this manual may not be visible when displayed at lower resolutions.

A When this manual is viewed in a pdf reader, the links at the top of each page can be used for chapter navigation. Click  to return to this page.

A This manual assumes that default camera and software settings are used.

A See online help for more information on the features described in this manual or on Short Movie Creator, Panorama Maker, and any other software bundled with ViewNX 2. Help can be accessed from 

the Help menu at the top of the application window.
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ViewNX 2: An OverviewViewNX 2: An Overview
ViewNX 2 is used to copy photographs and movies from your camera to a com-
puter, where they can then be viewed, retouched, printed, or uploaded to social 
networking sites.

Digital camera Computer

Shoot Connect

Nikon Transfer 2 1

Transfer

Nikon Movie Editor 1 ViewNX 2

View/select/fi nd/retouch

 E-mail  Websites  Print

1 Installed automatically with ViewNX 2.

ViewNX 2ViewNX 2

1

3

5

2

4
6

 1 Select tools: Use the menus and tool buttons to access program features.

 2 Find pictures: Display only images that match the selected conditions.

 3 Choose folders: Select the folder containing the pictures you want to view.

 4 Retouch pictures/view photo info: Use the retouch tools or view the shooting info  
(metadata) embedded in pictures.

 5 Rate pictures: Rate or label selected pictures.

 6 View pictures: Pictures are displayed in this area. You can choose the size at 
which pictures are displayed.

A NEF (RAW) fi les recorded with cameras that are not supported under the installed version of 

ViewNX 2 may not transfer correctly. Be sure to always use the latest version of ViewNX 2.
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Installing ViewNX 2: WindowsInstalling ViewNX 2: Windows
Before installing ViewNX 2 under Windows, be sure that the system meets the 
following requirements:

CPUCPU

• Photos/JPEG movies: 1.6 GHz Intel Celeron, Pentium 4 or Core series or better

• H.264 movies (playback): 3.0  GHz Pentium D or better; Intel Core i5 or better recommended 

when viewing movies with a frame size of 1280 × 720 or more at a frame rate of 30 fps or above 

or movies with a frame size of 1920 × 1080 or more

• H.264 movies (editing): 2.6 GHz Core 2 Duo or better

OSOS

Pre-installed versions of Windows 8/Windows 8 Pro/Windows 8 Enterprise  (64- and 32-bit edi-

tions), Windows 7 Home Basic/Home Premium/Professional/Enterprise/Ultimate (64- and 32-bit 

editions; Service Pack 1), Windows Vista Home Basic/Home Premium/Business/Enterprise/Ulti-

mate (64-and 32-bit editions; Service Pack 2), or Windows XP Home Edition/Professional (32-bit 

editions only; Service Pack 3). Note that only ViewNX 2 and Picture Control Utility run as native 

64-bit applications under 64-bit editions of Windows.

RAMRAM • Windows 7/Windows Vista: 1 GB or more (2 GB or more recommended)

• Windows XP: 512 MB or more (2 GB or more recommended)

Hard-disk Hard-disk 
spacespace A minimum of 1 GB available on the startup disk (3 GB or more recommended)

MonitorMonitor • Resolution: 1024×768 pixels (XGA) or more (1280×1024 pixels (SXGA) or more recommended)

• Color: 24-bit color (True Color) or more

A Some features require an Internet connection. 

A Microsoft DirectX 9 or later is required for playback of movies in WMV and MPEG1 formats.

To install ViewNX 2 from a CD supplied with the camera, follow the steps below.

 1 Start the computer and insert the installer CD.

 2 A language-selection dialog will be displayed. Select a language and click 
Next.

A If the desired language is not available, click Region Selection to choose a diff erent region 

and then choose the desired language (region selection is not available in the European 

release).

 3 Follow the on-screen instructions to complete installation.

AA Launching the Installer Manually Launching the Installer Manually
If the installer does not start automatically, click the Windows start button, select Computer or My 

Computer, and double-click the CD icon.

AA Downloading ViewNX 2 Downloading ViewNX 2
The ViewNX 2 installer can be downloaded from the following website:

http://nikonimglib.com/nvnx/http://nikonimglib.com/nvnx/

Choose a region and language and follow the on-screen instructions to download the installer. 

Once download is complete, double-click the installer and follow the on-screen instructions to 

install ViewNX 2. 



Contents IntroductionIntroduction Image Transfer Viewing Pictures Selecting Pictures Finding Pictures Retouching Pictures Printing Pictures Other Features

ViewNX 2 Reference Manual 5

Installing ViewNX 2: Mac OSInstalling ViewNX 2: Mac OS
Before installing ViewNX 2 under Mac OS, be sure that the system meets the 
following requirements:

CPUCPU

• Photos/JPEG movies: Intel Core or Xeon series

• H.264 movies (playback): 2 GHz Core Duo or better; Intel Core i5 or better recommended when 

viewing movies with a frame size of 1280 × 720 or more at a frame rate of 30 fps or above or 

movies with a frame size of 1920 × 1080 or more

• H.264 movies (editing): 2.6 GHz Core 2 Duo or better

OSOS Mac OS X version 10.6.8, 10.7.5, or 10.8.2

RAMRAM 512 MB or more (2 GB or more recommended)

Hard-disk Hard-disk 
spacespace A minimum of 1 GB available on the startup disk (3 GB or more recommended)

MonitorMonitor • Resolution: 1024×768 pixels (XGA) or more (1280×1024 pixels (SXGA) or more recommended)

• Color: 24-bit color (millions of colors) or more

A Some features require an Internet connection.

To install ViewNX 2 from a CD supplied with the camera, follow the steps below.

 1 Start the computer and insert the installer CD. A CD icon will ap-
pear on the desktop; double-click the icon to view the contents of 
the CD.

 2 Double-click the Welcome icon to launch the installer.

 3 A language-selection dialog will be displayed. Select a language and click 
Next.

A If the desired language is not available, click Region Selection to choose a diff erent region 

and then choose the desired language (region selection is not available in the European 

release).

 4 Follow the on-screen instructions to complete installation.

AA Downloading ViewNX 2 Downloading ViewNX 2
The ViewNX 2 installer can be downloaded from the following website:

http://nikonimglib.com/nvnx/http://nikonimglib.com/nvnx/

Choose a region and language and follow the on-screen instructions to download the installer. 

Once download is complete, double-click the installer and follow the on-screen instructions to 

install ViewNX 2. 
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Launching Nikon Transfer 2Launching Nikon Transfer 2
Nikon Transfer 2 launches automatically when a Nikon digital camera is con-

nected or a camera memory card is inserted in card reader or card slot. It can 

also be launched manually from ViewNX 2.

AA Nikon Transfer 2 Nikon Transfer 2
Nikon Transfer 2 is used to copy pictures from the camera to the computer and is installed automati-

cally when you install ViewNX 2. If you have purchased a new camera since installing ViewNX 2, be 

sure to upgrade to the latest version, as earlier versions may corrupt NEF (RAW) fi les recorded by 

late-model cameras.

Direct ConnectionDirect Connection
Nikon Transfer 2 launches automatically when a camera is detected.

 1 Turn the camera off  and connect it to the computer using the designated 

USB cable (use the cable supplied with the camera if applicable, or use the 

optional USB cable designated for use with your camera).

A To transfer pictures from a memory card, be sure that the card is inserted in the camera 

before proceeding. If the camera is equipped with built-in memory, pictures can be trans-

ferred from built-in memory by removing the memory card before proceeding.

 2 If necessary, turn the camera on. Nikon Trans-

fer 2 will launch automatically (if a message is 

displayed prompting you to choose a program, 

select Nikon Transfer 2).

A Windows 7: If Windows displays the dialog at right, click 

Change program under Import pictures and videos 

and select Import fi le using Nikon Transfer 2.

Card ReadersCard Readers
Pictures can be copied from camera memory cards using built-in card slots or 

an external card reader connected to the computer.

 1 If you are using an external card reader, connect it to the computer as de-

scribed in the documentation provided with the device.

 2 Insert the memory card in the card reader or 

card slot. Nikon Transfer 2 will launch automati-

cally (if a message is displayed prompting you 

to choose a program, select Nikon Transfer 2).

Manual LaunchManual Launch
Nikon Transfer 2 can be launched by clicking the  (Transfer) button in the 

ViewNX 2 toolbar. Launch Nikon Transfer 2 manually to change transfer settings 

before connecting a camera or inserting a memory card.
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Copying Pictures to a ComputerCopying Pictures to a Computer
Use Nikon Transfer 2 to copy pictures to the computer.

Copying All PicturesCopying All Pictures
At default settings, all new pictures on the camera memory card or in the cam-

era’s built-in memory can be copied to the computer by clicking Start Transfer 

in Nikon Transfer 2. The pictures will automatically be displayed in ViewNX 2 

when transfer is complete.

Start Transfer

Copying Selected PicturesCopying Selected Pictures
To copy only selected pictures, follow the steps below.

 1 Enlarge the window by dragging the frame until you can see all the pic-

tures in the “Thumbnails” area.

“Thumbnails” area “Thumbnails” area

 2 Click the check boxes to select or deselect pictures.

Picture selected. Click to deselect. Picture not selected. Click to select.

 3 Click Start Transfer to copy the selected pictures to the computer.
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Copying Pictures to a Computer

Default DestinationsDefault Destinations
At default settings, pictures are copied to new sub-folders automatically cre-

ated under the “Nikon Transfer 2” folder and named in ascending order, starting 

with “001” (“001”, “002”, “003”, …). The folder is displayed in the ViewNX 2 “Fold-

ers” area.

“Folders” area

The location of the “Nikon Transfer 2” folder and sub-folders is shown below.

Windows 7/Windows VistaWindows 7/Windows Vista Windows XPWindows XP

(User name)\My Pictures\Nikon Transfer 2\001 My Documents\My Pictures\Nikon Transfer 2\001

User name

Mac OSMac OS

Users : (user name) : Pictures : Nikon Transfer 2 : 001

User name
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Copying Pictures to a Computer

Changing the DestinationChanging the Destination
To change the destination for new images copied to the computer, click the 

next to “Options” and open the “Primary Destination” tab.

Choose the destination 

folder.

Choose the rules for naming new sub-folders in 

the destination folder.

AA Renaming Files During Transfer Renaming Files During Transfer
To copy the fi les to the destination under a new name, select Rename fi les during transfer and 

click Edit to choose the fi le naming rules. For more information, select Help > ViewNX 2 Help… > 

Transferring Files > Transfer Options > Renaming Files During Transfer.

■ Choosing a Destination: Example 1
To save pictures to the “Nikon Transfer 2” folder grouped in sub-folders named 

according to the date the pictures were taken:

 1 Select “Nikon Transfer 2” (the default op-

tion) for Primary destination folder.

 2 Select Create subfolder for each transfer 

and click Edit.

 3 The dialog shown at right will be dis-

played. Choose Date shot from the menu 

in the center and select Do not add trail-

ing number.

 4 Click OK to exit the folder naming dialog. 

When you click Start Transfer to copy 

pictures to the computer, the pictures 

will be saved to the “Nikon Transfer 2” 

folder grouped in sub-folders named for 

the date the pictures were taken (e.g., 

“20110801”).

Sub-folder for pictures shot on 

August 1, 2011
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Copying Pictures to a Computer

■ Choosing a Destination: Example 2
To save pictures to the “Nikon Transfer 2” folder in a sub-folder named “Kyoto”:

 1 Select “Nikon Transfer 2” (the default op-

tion) for Primary destination folder.

 2 Select Choose subfolder under Primary 

Destination folder and enter “Kyoto” in 

the “Primary Destination” text box.

 3 When you click Start Transfer to copy pic-

tures to the computer, the pictures will be 

saved to the “Nikon Transfer 2” folder in a 

sub-folder named “Kyoto”.

D If the folder already contains fi les with the same 

names as the pictures being copied, the new 

pictures will be renamed by adding numbers to 

the ends of the fi le names.
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Copying Pictures to a Computer

• Disconnect automatically after transfer: End the connection with the camera or 

memory card when transfer is complete. Default: On
• Delete original fi les after transfer: Delete transferred pictures from the camera or 

memory card when transfer is complete. Default: Off 
• Open destination folder with the following application after transfer: Display the desti-

nation folder in the selected application when transfer is complete. The ap-

plication can be selected from the menu: choose from ViewNX 2, Windows 

Explorer (or, in Mac OS, the Finder), or select Browse… to choose another ap-

plication. Default: On/ViewNX 2

A Use Nikon Transfer 2 to transfer fi les such as Motion Snapshots, voice memos, and pictures taken 

with the Smart Photo Selector.

Transfer PreferencesTransfer Preferences
The settings listed below can be accessed in the “Options” area “Preferences” 

tab. Default values are recommended.

■ Preferences
• Add additional information to fi les: Add XMP/IPTC metadata to pictures during 

transfer. Choose a preset from the menu or click Edit to modify the selected 

preset. The options listed below are available when Add additional informa-

tion to fi les is selected. Default: On
 ❖ Embed ICC color profi le during transfer: JPEG and TIFF fi les include the ICC color 

profi les embedded in the images when the pictures were taken. Default: Off 
 ❖ Always use ratings applied on original fi les (supported cameras only): The ratings cho-

sen with the camera are used in place of the labels specifi ed in the XMP/IPTC 

preset. Default: On
• Transfer new fi les only: Only fi les that have not previously been copied to the 

computer will be transferred. Default: On
• Synchronize camera date and time to computer when camera is connected (supported cam-

eras only): The camera clock is synchronized with the computer each time the 

camera is connected (the camera clock can also be synchronized with the 

computer by clicking Synchronize). This option applies only when a support-

ed camera is connected via MTP/PTP, PTP, or IEEE 1394 (Firewire). Default: On
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ThumbnailsThumbnails
At default settings, ViewNX 2 will launch when transfer is complete and display 

the pictures in the thumbnail area. Selected pictures are highlighted.

Thumbnail area

Selected picture

Click pictures to select or click  or  to select the picture before or after the current picture.

AA Full-Screen Display Full-Screen Display
To view a picture full screen (page full screen (page 1414)), double-click the thumbnail.

 Thumbnail Size Thumbnail Size
Use the slider at the top of the thumbnail area to adjust thumbnail size. Drag 

the slider left to shrink the thumbnails and increase the number of pictures vis-

ible in the thumbnail area, right to display thumbnails at a larger size.

Slider

 Display Options Display Options
Use the buttons below to rotate pictures or display the focus area.

View or hide the focus areas used to take the pictures in the thumbnail area.

Rotate selected pictures 90° counterclockwise.

Rotate selected pictures 90° clockwise.

AA Image Viewer/Full-Frame Display Image Viewer/Full-Frame Display
The focus point and rotate buttons can also be used in the image viewer (page image viewer (page 1313)) and full-screen full-screen 

(page (page 1414)) displays.
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 The Image Viewer The Image Viewer
ViewNX 2 off ers a choice of view modes. Select “Image Viewer” mode to display 

pictures as thumbnails across the bottom of the window, with the current pic-

ture shown at a larger size in a central image area.

To open the image viewer, click the view mode 

button at the left side of the display under the 

toolbar and select Image Viewer.

Thumbnails will be displayed in a “fi lmstrip” across the bottom of the window, 

with the current picture shown in the image area at the center.

Image area

Filmstrip

Click a picture to display it in the image area or click  or  to display the picture before or 

after the current picture.

AA Full-Screen Display Full-Screen Display
To view the picture full screen (page full screen (page 1414)), double-click the picture in the image area.

AA Thumbnail Display Thumbnail Display
To return to the thumbnail view, click the view mode ( ) button and select Thumbnail Grid.

Display OptionsDisplay Options
Use the buttons below to view or hide image information or choose the zoom 

ratio for pictures displayed in the image area.

View or hide image information.

View or hide histograms.

Fit pictures to the image area (Fit to Screen) or display all pictures at the zoom ratio used for 

portrait (“tall” orientation) pictures (Fit to Square).

Drag the slider right to zoom in, left to zoom out. To view the entire image, drag the slider all 

the way to the left.
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 Full-Screen Display Full-Screen Display
ViewNX 2 off ers a choice of view modes. Select “Full Screen” mode to display 

pictures at a size that fi lls the monitor.

 1 Select a thumbnail.

 2 Click the view mode button at the left 

side of the display under the toolbar and 

select Full Screen.

The selected picture will be displayed at a size that fi lls the monitor.

Click  or  to display the picture before or after the current picture.

AA Thumbnail Display Thumbnail Display
Click  to exit the full-screen display, or click the view mode ( ) button and select Thumbnail 

Grid to return to the thumbnail view.

Display OptionsDisplay Options
Use the buttons below to choose the view mode, rotate pictures, view or hide 

image information, or choose the zoom ratio.

Choose the view mode.

Rotate the current picture 90° counterclockwise.

Rotate the current picture 90° clockwise.

View or hide image information.

View or hide histograms.

Fit pictures to the monitor (Fit to Screen) or display all pictures at the zoom ratio used for por-

trait (“tall” orientation) pictures (Fit to Square).

Drag the slider right to zoom in, left to zoom out. To view the entire image, drag the slider all 

the way to the left.

Exit to the previous view mode.
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Photo Info (Metadata)Photo Info (Metadata)
Information on the current picture is listed in the “Metadata” palette.

Selected picture

“Metadata” palette

AA Metadata Metadata
“Metadata” takes the form of text embedded in image fi les and may include fi le or photo informa-

tion such as the date of recording, exposure, and focal length.

Viewing MetadataViewing Metadata
To view metadata, click the  at the top of the “Metadata” palette.

AA The Palette Area The Palette Area
If the palette area is hidden, palettes can be displayed by 

clicking the  to the right of the thumbnail or image area.

Display OptionsDisplay Options
Use the menu in the palette title bar to choose 

the information visible in the “Metadata” pal-

ette (at default settings, all information is dis-

played). To display only selected categories, 

choose Custom Settings… and place checks 

next to the categories you wish to view. 
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Viewing Pictures Taken with the Smart Photo SelectorViewing Pictures Taken with the Smart Photo Selector
When viewing pictures taken with the Smart Photo Selector (available on se-

lected Nikon cameras), you can use the  button under the toolbar to choose 

whether to display the best shot candidates.

When the button is on ( ), only the best shot will 

be displayed. Click the button to view the 

best shot candidates.

When the button is off  ( ), the best shot candi-

dates will be displayed together with the best 

shot. Click the button to hide the best shot 

candidates.

AA The Best Shot and Best Shot Candidates The Best Shot and Best Shot Candidates
The best shot is indicated by a  icon, the best shot candidates by  icons.

Best Shot CandidatesBest Shot Candidates
When the best shot candidates are hidden, any operations applied to the best 

shot also apply to the best shot candidates. For example, if protection is applied 

to the best shot when the best shot candidates are hidden, the best shot can-

didates will also be protected. When the best shot candidates are visible, how-

ever, ViewNX 2 treats them as separate images. Performing any of the following 

operations on the best shot candidates will permanently end their association 

with the best shot and prevent the best shot and best shot candidates from be-

ing handled as a group:

• Editing the pictures

• Rotating the pictures

• Renaming the pictures

• Moving the pictures to another folder

• Labeling or rating the pictures

• Editing picture metadata (XMP/IPTC information)

• Editing GPS data

• Editing or renaming the pictures in another application

AA Deleting the Best Shot and Best Shot Candidates Deleting the Best Shot and Best Shot Candidates
When the best shot candidates are hidden, deleting the best shot will also delete the best shot 

candidates. When the best shot candidates are visible, deleting a best shot candidate will not end 

the association between the best shot and the remaining candidates; if the best shot is deleted, 

however, the best shot candidates will no longer be grouped together and will be treated as sepa-

rate images.
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Slide ShowsSlide Shows
To view the pictures in the fi lmstrip or thumbnail area in a slide show:

 1 Click the  (Slide Show) button in the toolbar.

 2 The dialog shown at right will be dis-

played. Adjust settings (page Adjust settings (page 1818)) and click 

OK to start the show.

AA Ending the Slide Show Ending the Slide Show
Press Esc to exit the show before it is complete.

 Selecting Pictures Selecting Pictures
To select pictures for the slide show:

 1 Click a picture in the thumbnail area to se-

lect it. The selected picture is highlighted 

in gray.

 2 Click additional images while keeping the 

Ctrl key (or in Mac OS, the /command 

key) pressed.

A To select two pictures and all images between 

them, click the pictures while pressing Shift.

 3 Click the  (Slide Show) button in the toolbar to start the show.

AA Viewing All Images Viewing All Images
To create a slide show that includes all images in the fi lmstrip or thumbnail area, click the  (Slide 

Show) button with one or no images selected.
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Slide Shows

Slide Show SettingsSlide Show Settings
The slide show settings dialog contains the fol-

lowing options:

• Toolbar: Choose whether rating, label, and 

other controls are displayed during the show.

• Transitions: Choose the transitions between 

slides.

• Show each slide for: Choose how long each slide 

is displayed.

• Show image information: Choose whether to dis-

play image information during the show.

• Show Histogram: Choose whether to display 

histograms during the show.

• Repeat Slideshow: If this option is selected, the slide show will repeat until you 

click  or press Esc to end the show.

• Don’t show this dialog again: Select this option to start future slide shows without 

displaying the settings dialog.

Slide Show ControlsSlide Show Controls
The controls listed below can be displayed during the show.

// Skip to the previous or following slide.

// Click  to pause playback,  to resume.

View or hide image information.

View or hide histograms.

Label the current picture.

Rate the current picture.

End the slide show and exit to the previous view mode.
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Movie PlaybackMovie Playback
QuickTime (“*.mov”) and AVI movies can be played in the image viewer and full-

screen displays. This section describes how to play movies in the image viewer.

 1 Select a movie fi le in the fi lmstrip. The 

fi rst frame will appear in the image area.

 2 Click  to start movie playback.

AA Full-Screen Display Full-Screen Display
To view a movie full screen, highlight it in the fi lmstrip or thumbnail area and select Full Screen 

from the view mode menu.

AA Rating Movies Rating Movies
Although existing ratings (page ratings (page 2020)) can be changed, ratings can not be assigned to previously un-

rated movies.

Movie Playback ControlsMovie Playback Controls
The controls listed below are available during movie playback.

// Click  to start or resume playback,  to pause.

// Click  to rewind,  to fast forward.
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 Rating Pictures Rating Pictures
Selected pictures can be rated using the control at the bottom of the window (if 

monitor resolution is too low to display the rating control, pictures can be rated 

in the Image > Apply Ratings menu). Choose from ratings of from one to fi ve 

stars,  (no rating), or  (discard).

Ratings

AA Ratings Ratings
Ratings and labels can be used to select pictures for display, slide shows, printing, and for fi le opera-

tions such as deleting pictures or copying them to other folders. The  (discard) rating can be used 

to select pictures for later deletion.

Ratings assigned in ViewNX 2 can also be viewed in Capture NX 2 and other Nikon software.

To rate pictures:

 1 Select a picture you want to rate.

A To assign the same rating to multiple pictures, 

select the pictures as described on page page 1717.

 2 Click the desired rating or select a rating in the Image  > Apply Ratings 

menu.

To assign the picture a three-star rating, 

click the third star from the left. The fi rst 

three stars will be highlighted in yellow.

A If ratings are not displayed under thumbnails, choose a larger thumbnail size (page thumbnail size (page 1212)).

A To de-rate the selected picture, click .
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 Labelling Pictures Labelling Pictures
To make pictures easier to sort and locate, you can label them using the control 

at the bottom of the window or the options in the Image > Apply Labels menu. 

Each of the labels from “0” (no label) through “9” has its own color and can be 

assigned its own unique name.

Labels

AA Labels Labels
Labels and ratings can be used to select pictures for display.

To label pictures:

 1 Select a picture you want to label.

A To label multiple pictures, select the pictures as 

described on page page 1717.

 2 Click the desired label or select a label in the Image > Apply Labels menu.

Clicking 7 assigns the label “7”.

A To remove the label, click 0.

A Movies can not be labelled.

DD Compatibility Compatibility
Ratings assigned in ViewNX 2 can also be viewed in Capture NX 2 and other Nikon software. Chang-

ing label colors will however render the labels incompatible, potentially resulting in labels being 

displayed in colors that diff er from those selected.
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Sorting PicturesSorting Pictures
Pictures can be sorted by name, date, rating (page rating (page 2020)), label (page label (page 2121)), or fi le size or 

type. Rating or labelling pictures according to your own system can make them 

easier to fi nd.

Sort

For example, to sort pictures in ascending order by rating (one star, two stars, 

three stars …):

 1 Click the Sort triangle to display the sort 

menu.

A The sort menu is not available in full-screen 

mode. To exit full-screen mode, select another 

view mode from the view mode menu at the top 

left corner of the display.

 2 Select a sort option (in this example, Rat-

ing).

A The currently selected option is indicated by a 

check mark.

 3 Select a sort order (in this example, As-

cending).

A The currently selected option is indicated by a 

check mark.

The pictures in the thumbnail area or 

fi lmstrip will be listed by the selected key 

in the selected order (in this example, in 

ascending order by rating).
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FilteringFiltering
Pictures can be fi ltered by rating, label, and fi le type, making it easier to select 

pictures for slide shows, deletion, and other operations. This example shows 

how to fi lter pictures by rating.

 1 Click Filter at the right side of the display under the toolbar to display the 

fi lter bar.

A Filtering is not available in full-screen mode. To exit full-screen mode, select another view 

mode from the view mode menu at the top left corner of the display.

 2 Choose a fi lter or fi lters from the options in the fi lter bar. In this example, 

we will adjust settings to show only pictures with a rating of from two to 

four stars.

Rating fi lter

Label fi lter File-type fi lter

A Multiple fi lters can be used to further restrict the pictures displayed. For example, after 

selecting a rating fi lter, we could add fi lters to display only JPEG pictures with a rating of 

from two to four stars and the label “1”.

The thumbnail list and fi lmstrip will show only pictures that match the se-

lected fi lter.

AA “Clear All” “Clear All”
To display all the images in the current folder, click Clear All.
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Filtering

Filtering Pictures by RatingFiltering Pictures by Rating
To fi lter pictures by rating (page rating (page 2020)), use the rat-

ing fi lter sliders to choose the desired range of 

ratings. A check mark will appear next to the 

rating fi lter. To clear the fi lter, click the check 

mark.

Filter adjusted to display only pictures 

with ratings of two, three, or four stars.

DD Non-Consecutive Ratings Non-Consecutive Ratings
The ratings fi lter does not support non-consecutive ratings. For example, it can not be used to 

display only pictures with ratings of either one or fi ve stars.

Filtering Pictures by LabelFiltering Pictures by Label
To fi lter pictures by label (page label (page 2121)), click the de-

sired label in the label fi lter. To select multiple 

labels, keep the Ctrl key (or in Mac OS, the 

/command key) pressed while clicking each 

label in turn. A check mark will appear next 

to the label fi lter. To clear the fi lter, click the 

check mark.

Filter adjusted to display only pictures 

labelled “3” or “7”.

Filtering Pictures by File TypeFiltering Pictures by File Type
To fi lter pictures by fi le type, choose an option 

from the fi le-type fi lter menu. A check mark 

will appear next to the selected type. Only one 

option can be selected at a time, although the 

Images, Movies, and Show Voice Recordings 

options can be used to fi lter images further. 

Select All to cancel fi le-type fi ltering.
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The Edit DisplayThe Edit Display
To edit pictures, click the  (Edit) button in the toolbar. An edit area, fi lmstrip, 

and “Adjustments” palette will be displayed, with the current picture highlight-

ed in the fi lmstrip and shown in the edit area.

Edit area “Adjustments” palette

Filmstrip

Tool SelectionTool Selection
Use the tool selection menu to choose the tools displayed in the “Adjustments” 

palette and use the scroll bar to scroll through the tools displayed.

■ The Tool Selection Menu
Use the menu in the palette title bar to choose 

the tools displayed in the “Adjustments” pal-

ette.

• All (default): Display all image adjustment tools.

• Quick: Display a selection of image adjustment tools.

• Custom Settings…: Choose tools from a tool selection dialog. Place checks next 

to the tools you want to display and click OK.

■ The Scroll Bar
Use the scroll bar to view tools not currently 

visible in the display.
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SharpnessSharpness
Use the Sharpness tool in the “Adjustments” palette to sharpen outlines.

 1 Click the  (Edit) button in the toolbar. The current picture will appear in 

the edit area and the “Adjustments” palette will be displayed.

 2 Choose a thumbnail in the fi lmstrip to display the picture in the edit area.

 3 Drag the scroll bar in the “Adjustments” 

palette to display the Sharpness tool and 

adjust sharpness using the slider or by 

entering a value in the text box. Choose 

from values between 0 (off ) and 10: the 

higher the number, the greater the eff ect. 

The eff ects are visible on the picture in 

the edit area; for greater accuracy, zoom 

in on the image as described on page page 1313.

AA Sample Sample

AA Cancelling Changes Cancelling Changes
Click Reset to cancel all changes and restore tools to their default settings.

AA Saving Changes Saving Changes
Click  (“Save”) to save the edited picture under its current name, or  (“Save As”) to save a copy 

under a new name. See page page 3232 for more information on saving JPEG and TIFF images, page page 3838 for 

information on saving NEF/NRW (RAW) images.
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ContrastContrast
Use the Contrast tool in the “Adjustments” palette to adjust contrast.

 1 Click the  (Edit) button in the toolbar. The current picture will appear in 

the edit area and the “Adjustments” palette will be displayed.

 2 Choose a thumbnail in the fi lmstrip to display the picture in the edit area.

 3 Drag the scroll bar in the “Adjustments” 

palette to display the Contrast tool and 

adjust contrast using the slider or by en-

tering a value between –100 and +100 

in the text box. Choose lower values to 

reduce contrast, higher values to increase 

contrast, or select 0 to turn contrast ad-

justment off .

AA Sample Sample

AA Cancelling Changes Cancelling Changes
Click Reset to cancel all changes and restore tools to their default settings.

AA Saving Changes Saving Changes
Click  (“Save”) to save the edited picture under its current name, or  (“Save As”) to save a copy 

under a new name. See page page 3232 for more information on saving JPEG and TIFF images, page page 3838 for 

information on saving NEF/NRW (RAW) images.
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BrightnessBrightness
Use the Brightness tool in the “Adjustments” palette to adjust brightness.

 1 Click the  (Edit) button in the toolbar. The current picture will appear in 

the edit area and the “Adjustments” palette will be displayed.

 2 Choose a thumbnail in the fi lmstrip to display the picture in the edit area.

 3 Drag the scroll bar in the “Adjustments” 

palette to display the Brightness tool and 

adjust brightness using the slider or by 

entering a value between –100 and +100 

in the text box. Choose lower values to 

make the image darker, higher values to 

make it brighter, or select 0 to turn bright-

ness adjustment off .

AA Sample Sample

AA Cancelling Changes Cancelling Changes
Click Reset to cancel all changes and restore tools to their default settings.

AA Saving Changes Saving Changes
Click  (“Save”) to save the edited picture under its current name, or  (“Save As”) to save a copy 

under a new name. See page page 3232 for more information on saving JPEG and TIFF images, page page 3838 for 

information on saving NEF/NRW (RAW) images.
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CropCrop
Use the Crop tool in the “Adjustments” palette to trim unwanted areas from im-

ages.

 1 Click the  (Edit) button in the toolbar. The current picture will appear in 

the edit area and the “Adjustments” palette will be displayed.

 2 Choose a thumbnail in the fi lmstrip to display the picture in the edit area.

 3 Drag the scroll bar in the “Adjustments” 

palette to display the Crop tool.

 4 Choose an aspect ratio from the pull-

down menu. Select Free Crop for a free-

size crop, or choose a fi xed aspect ratio to 

constrain the crop according to how the 

fi nal picture will be printed or displayed.

A For example, choose 8 × 10 Portrait when or-

dering a 8″ × 10″ portrait print, or 9 × 16 Land-

scape for a picture that will be displayed on an 

HD TV.

 5 Click Start. The cursor will change to ; 

drag the cursor over the image to select 

the crop.

AA Positioning the Crop Positioning the Crop
To position the crop, place the cursor inside the crop borders (the cursor will change to ) 

and drag the crop to the desired location.
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Crop

AA Resizing the Crop Resizing the Crop
To resize the crop, place the cursor over one of the crop borders (the cursor will change to a 

double arrow) and drag the border until the crop is the desired size.

If an option other than Free Crop is selected, the crop will automatically be adjusted to main-

tain the selected aspect ratio.

 6 To crop the picture, click Apply or double-click inside the crop.

Click Apply

To cancel the operation before cropping the picture, click Cancel.

DD “Use Gray Point” “Use Gray Point”
Other image adjustments can be made before the crop is applied without cancelling the crop. 

Note, however, that the crop will be cancelled if Use Gray Point is selected for White Balance 

before the crop is applied.

AA Cropping Multiple Pictures Cropping Multiple Pictures
Pictures are cropped to the selected aspect ratio, which may produce unexpected results with 

some images. If multiple pictures are selected, the fi rst picture in the selection (the leftmost picture 

in the top row of the selection in the thumbnail area or the leftmost picture in the selection in the 

fi lmstrip) will determine the aspect ratio.

AA Cancelling Changes Cancelling Changes
Click Reset to cancel all changes and restore tools to their default settings.

AA Saving Changes Saving Changes
Click  (“Save”) to save the edited picture under its current name, or  (“Save As”) to save a copy 

under a new name. See page page 3232 for more information on saving JPEG and TIFF images, page page 3838 for 

information on saving NEF/NRW (RAW) images.
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StraightenStraighten
Use the Straighten tool in the “Adjustments” palette to straighten pictures.

 1 Click the  (Edit) button in the toolbar. The current picture will appear in 

the edit area and the “Adjustments” palette will be displayed.

 2 Choose a thumbnail in the fi lmstrip to display the picture in the edit area.

 3 Drag the scroll bar in the “Adjustments” 

palette to display the Straighten tool and 

straighten the picture using the slider or 

by entering a value between –10.0 and 

+10.0 in the text box. Choose lower val-

ues to rotate the picture to the left, higher 

values to rotate it to the right, or select 0 

to turn straightening off .

AA Sample Sample

AA Straightening Pictures Straightening Pictures
Pictures are automatically cropped after straightening to square the edges, making the straight-

ened picture smaller than the original.

AA Cancelling Changes Cancelling Changes
Click Reset to cancel all changes and restore tools to their default settings.

AA Saving Changes Saving Changes
Click  (“Save”) to save the edited picture under its current name, or  (“Save As”) to save a copy 

under a new name. See page page 3232 for more information on saving JPEG and TIFF images, page page 3838 for 

information on saving NEF/NRW (RAW) images.
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 Saving JPEG and TIFF Pictures Saving JPEG and TIFF Pictures
The  (“Save As”) and  (“Save”) buttons are used to save JPEG and TIFF pic-

tures after retouching. To abandon all changes and restore the original image 

without saving it to disk, click Reset.

 (“Save As”) (“Save As”)
Save changes to a new fi le, leaving the original image untouched.

 1 After retouching the picture, click  (“Save 

As”). The dialog at right will be displayed.

 2 Choose a folder and enter a fi le name.

 3 Click Save.

 (“Save”) (“Save”)
Save the retouched picture under its original fi le name.

 1 After retouching the picture, click  (“Save”). 

A confi rmation dialog will be displayed.

 2 Click OK. The retouched picture will be saved under its original fi le name; 

at default settings, a copy of the original, unmodifi ed image will be created 

in the “Originals” folder.

A The “Originals” folder is automatically created in the same folder as the current picture.

DD Retouching Multiple Pictures Retouching Multiple Pictures
When multiple pictures are selected, any changes to the picture in the edit area also apply to the 

other pictures in the selection (in the case of tools that apply only to specifi c image types, the 

changes will be applied only to pictures of the supported type; the remaining pictures are unaf-

fected).

DD “Confi rm Image Change” “Confi rm Image Change”
If you select another picture or attempt to exit the edit display without fi rst saving changes, a con-

fi rmation dialog will be displayed. Click Yes to save the picture under its current fi le name.
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 Convert File Convert File
The JPEG, TIFF, and NEF/NRW (RAW) pictures currently displayed in the image or 

edit areas or selected in the thumbnail area or fi lmstrip can be exported as JPEG 

or TIFF fi les. When exporting pictures, you can choose the size and opt to strip 

out photo info, XMP/IPTC information, and color profi les.

 1 Select pictures for export.

 2 Click the  (Convert File) button in the toolbar.

 3 The following dialog will be displayed. Adjust settings as desired.

Choose a format for the exported pictures.

Use the slider to choose the compression 

ratio (image quality) when exporting pic-

tures in JPEG format.

Select this option to export pictures at a 

selected size.

Use these options to strip photo info, XMP/

IPTC information, and/or color profi les 

from the exported pictures.

Choose the destination folder for the ex-

ported fi les. To choose a specifi c folder, se-

lect Specifi ed Folder and click Browse….

Select this option to export the selected 

pictures to a sub-folder automatically cre-

ated in the selected folder.

Select this option to rename the exported 

copies.

 4 Click Convert to export the pictures to the selected destination. If pictures 

with the same names already exist at the destination, the exported copies 

will be renamed by adding “_01” to the fi le name. The originals remain in 

the source folder.

DD JPEG Files JPEG Files
JPEG fi les exported in JPEG format may suff er a drop in image quality due to repeated compression. 

AA Export Export
The following can not be exported:

• Movies

• 3D images in MPO format

• WAV audio fi les

• NDF fi les containing Image Dust Off  reference data

• Files saved in NEF (RAW) format or converted from NEF (RAW) to JPEG or TIFF in Capture NX

• NEF (RAW) fi les edited using the nik Color Efex Pro 2.0 plug-ins for Nikon Capture 4 or PictureProject

• NEF (RAW) pictures shot using optional Picture Controls not installed with ViewNX 2

• Files edited in certain external applications

If the current selection includes both fi les that can exported and fi les that can not be exported, only 

the former will be exported.
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Creating Movies from Motion SnapshotsCreating Movies from Motion Snapshots
Follow the steps below to save Motion Snapshots in MOV format.

AA Motion Snapshots Motion Snapshots
Motion Snapshots (available with supported Nikon cameras) combine photographs with brief mov-

ie vignettes. In ViewNX 2, Motion Snapshots are indicated by a  icon.

 1 Select a Motion Snapshot.

 2 Select Convert Motion Snapshot to Mov-

ie in the File menu.

 3 The dialog shown below will be displayed. After navigating to the desired 

folder and choosing a fi le name, click Save to export the Motion Snapshot 

as a QuickTime (“*.mov”) movie. The original remains in the source folder.
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Retouching NEF/NRW (RAW) PicturesRetouching NEF/NRW (RAW) Pictures
The tools described on the following pages are available only with NEF/NRW 

(RAW) pictures.

AA NEF/NRW (RAW) NEF/NRW (RAW)
NEF/NRW (RAW) formats (“*.nef”, “.nrw”) record unprocessed data from the camera image sensor 

separately from camera and image retouch settings, allowing pictures to be retouched multiple 

times without aff ecting the original image data.

Exposure CompensationExposure Compensation
Adjust the exposure of NEF/NRW (RAW) pictures.

 1 Click the  (Edit) button in the toolbar. The current picture will appear in 

the edit area and the “Adjustments” palette will be displayed.

 2 Choose a thumbnail in the fi lmstrip to display the picture in the edit area.

 3 Drag the scroll bar in the “Adjustments” 

palette to display the Exposure Comp. 

tool and adjust exposure using the slider 

or by entering a value between –2.0 and 

+2.0 in the text box.

AA Sample Sample

AA Cancelling Changes Cancelling Changes
Click Reset to cancel all changes and restore tools to their default settings.

AA Saving Changes Saving Changes
Click  (“Save”) to save the edited picture under its current name, or  (“Save As”) to save a copy 

under a new name. See page page 3838 for more information.
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Retouching NEF/NRW (RAW) Pictures

White BalanceWhite Balance
Adjust white balance for NEF/NRW (RAW) pictures.

 1 Click the  (Edit) button in the toolbar. The current picture will appear in 

the edit area and the “Adjustments” palette will be displayed.

 2 Choose a thumbnail in the fi lmstrip to display the picture in the edit area.

 3 Drag the scroll bar in the “Adjustments” 

palette to display the White Balance tool 

and choose the desired setting from the 

menu.

 4 If an option other than Recorded Value is 

selected, you can choose the color tem-

perature by dragging the Fine Adjust-

ment slider or entering a value in the text 

box (the permitted values vary with the 

white balance option selected), and the 

tint by dragging the Tint slider or enter-

ing a value between –12 and +12 in the 

text box (choose lower values for less 

green and more magenta, higher values 

for the opposite eff ect).

AA Cancelling Changes Cancelling Changes
Click Reset to cancel all changes and restore tools to their default settings.

AA Saving Changes Saving Changes
Click  (“Save”) to save the edited picture under its current name, or  (“Save As”) to save a copy 

under a new name. See page page 3838 for more information.
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Retouching NEF/NRW (RAW) Pictures

 3 Drag the scroll bar in the “Adjustments” 

palette to display the Picture Control 

tool and then choose the desired Picture 

Control from the menu.

• [SD] Standard: Standard processing for 

balanced results.

• [NL] Neutral: Minimal processing for nat-

ural results. Choose for pictures that 

will later be extensively processed or retouched.

• [VI] Vivid: Pictures are enhanced for a vivid, photoprint eff ect.

• [MC] Monochrome: Display the picture in monochrome.

• [PT] Portrait: Process portraits for complexions with natural texture and a 

rounded feel.

• [LS] Landscape: Produces vibrant landscapes and cityscapes.

Nikon Picture Controls, optional Picture Controls, and Picture Controls cre-

ated with the Picture Control Utility can also be selected. To restore the Pic-

ture Control in eff ect when the picture was taken, select Recorded Value.

AA Cancelling Changes Cancelling Changes
Click Reset to cancel all changes and restore tools to their default settings.

AA Saving Changes Saving Changes
Click  (“Save”) to save the edited picture under its current name, or  (“Save As”) to save a copy 

under a new name. See page page 3838 for more information.

■ The Nikon Picture Control Utility
Use the Nikon Picture Control Utility to create, edit, import, and export custom 

Picture Controls.

DD COOLPIX Cameras COOLPIX Cameras
NEF (RAW) photographs shot with COOLPIX-series cameras are not supported.

Picture ControlsPicture Controls
Choose a Picture Control for NEF/NRW (RAW) pictures.

 1 Click the  (Edit) button in the toolbar. The current picture will appear in 

the edit area and the “Adjustments” palette will be displayed.

 2 Choose a thumbnail in the fi lmstrip to display the picture in the edit area.
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 Saving NEF/NRW (RAW) Pictures Saving NEF/NRW (RAW) Pictures
The  (“Save As”) and  (“Save”) buttons are used to save NEF/NRW (RAW) pic-

tures after retouching. To abandon all changes and restore the original image 

without saving it to disk, click Reset.

 (“Save As”) (“Save As”)
Save changes to a new fi le, leaving the original image untouched.

 1 After retouching the picture, click  (“Save As”). A “Save As” dialog will be 

displayed.

 2 Choose a folder and enter a fi le name.

 3 Click Save.

 (“Save”) (“Save”)
Click  (“Save”) to save the retouched picture under its original fi le name.

Saving the OriginalSaving the Original
Because the NEF and NRW (RAW) formats store image data separately from 

camera settings and image adjustments, the original picture can be restored at 

any time.

 1 Click   (“Restore Original”) to undo all 

image adjustments and restore the origi-

nal camera settings.

D All image adjustments will be lost.

 2 Click  (“Save”) to save the picture.

DD Retouching Multiple Pictures Retouching Multiple Pictures
When multiple pictures are selected, any changes to the picture in the edit area also apply to the 

other pictures in the selection (in the case of tools that apply only to specifi c image types, the 

changes will be applied only to pictures of the supported type; the remaining pictures are unaf-

fected).

DD “Confi rm Image Change” “Confi rm Image Change”
If you select another picture or attempt to exit the edit display without fi rst saving changes, a con-

fi rmation dialog will be displayed. Click Yes to save the picture under its current fi le name.

Exporting NEF/NRW (RAW) Pictures in JPEG/TIFF FormatExporting NEF/NRW (RAW) Pictures in JPEG/TIFF Format
To export NEF/NRW (RAW) pictures in JPEG/TIFF format, click the  (Convert 

File) button in the toolbar and select JPEG format (page page 3333).
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Other Image Adjustment ToolsOther Image Adjustment Tools
In addition to the sharpness, contrast, brightness, crop, and straighten tools, 

ViewNX 2 off ers the tools below.

Highlight Protection/Shadow Protection
Preserve details in highlights and shadows. 

Available with JPEG, TIFF, and NEF/NRW (RAW) 

images.

D-Lighting HS
Brighten shadows in backlit or poorly-lit pic-

tures or reduce loss of detail in highlights. 

Available with JPEG, TIFF, and NEF/NRW (RAW) 

images.

Color Booster
Adjust vividness (color saturation) in JPEG, 

TIFF, and NEF/NRW (RAW) images.

Auto Red-Eye
Reduce “red-eye” in pictures taken with a fl ash.

Axial Color Aberration
Reduce blurred colors caused by axial color 

aberration in JPEG, TIFF, and NEF/NRW (RAW) 

images.

A Axial color (chromatic) aberration (also referred to as “longitudinal chromatic aberration”) is 

caused by the lens focusing diff erent colors (wavelengths) of light at slightly diff erent distances, 

resulting in blurring around objects in the focal plane, particularly in the vicinity of very bright 

objects and in pictures taken with high-power lenses.

Auto Lateral Color Aberration
Automatically reduce colored fringes and ha-

los caused by lateral color aberration in JPEG, 

TIFF, and NEF/NRW (RAW) images.

A Lateral color (chromatic) aberration (also known as “transverse chromatic aberration”) is caused 

by the lens focusing diff erent colors (wavelengths) of light at slightly diff erent positions or mag-

nifi cations in the focal plane, resulting in colored fringes or halos around objects at the periphery 

of the image.
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The Movie EditorThe Movie Editor
Use Nikon Movie Editor to edit movies shot with Nikon digital cameras.

Movie StillsMovie Stills
Follow the steps below to save a frame from a movie as a JPEG still.

 1 Select a movie and click  (Movie Editor) in the tool bar to launch Nikon 

Movie Editor.

 2 Click  to start playback and click  when the desired frame is reached. 

When the movie is paused, the  and  buttons can be used to rewind or 

advance the movie one frame at a time.

 3 Click  (“Saves as image”).

 4 The dialog shown below will be displayed. Adjust settings as desired and 

click Save to save the selected frame as a JPEG image.

Name the new fi le.

Click Browse… to choose a destination.

Choose the compression ratio (image quality).

To save the picture at a size other than the original 

frame size, select Change image size and specify 

the length of the long edge in pixels.
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The Movie Editor

Combining Movies or StillsCombining Movies or Stills
Follow the steps below to combine selected stills or movie clips to create an 

original movie.

 1 Select the pictures and click  (Movie Editor) in the tool bar to launch Nikon 

Movie Editor.

A To select multiple images, drag to select the desired pictures in the thumbnail area or use 

the Shift or Ctrl (or in Mac OS, the /command) key. See page page 1717 for more information.

 2 Select pictures in the Nikon Movie Editor “Source” tab and click  (“Adds 

to storyboard”) to add the pictures to the storyboard. Drag pictures to ar-

range them in the desired order.

A To choose the transitions between the diff erent elements of the movie, open the “Transi-

tion” and drag the desired transitions into the small frames in the storyboard. To add back-

ground music, open the “Audio” tab and choose a WAV or AAC audio fi le (fi les protected by 

Digital Rights Management can not be used).

Storyboard

 3 Click  (“Creates movie”).

 4 The dialog shown below will be displayed. Adjust settings as desired and 

click Create to save the movie.

Name the new fi le.

Click Browse… to choose a destination.

Choose the fi le type.

Choose the frame size and rate.
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The Movie Editor

Creating Trimmed CopiesCreating Trimmed Copies
Follow the steps below to cut unwanted footage from the beginning or end of 

a movie.

 1 Select the movie and click  (Movie Editor) in the tool bar to launch Nikon 

Movie Editor.

 2 Select the movie in the Nikon Movie Editor “Source” tab and click  (“Adds 

to storyboard”) to add the movie to the storyboard.

Storyboard

 3 Select the movie in the storyboard and click  (“Trims movie”).

 4 The dialog at right will be displayed. Play 

the movie back; when you reach the start 

of the section you wish to keep, pause 

playback and click IN.

A Click  to start and resume playback and click 

 to pause. When the movie is paused, the  

and  buttons can be used to rewind or ad-

vance the movie one frame at a time.

 5 Resume playback. When you reach the 

end of the section you wish to keep, 

pause playback and click OUT.

 6 Click OK to trim the movie and return to Nikon Movie Editor.

 7 To save the trimmed copy, select it in the storyboard and click  (“Creates 

movie”) to display the “Create movie” dialog.

 8 Adjust settings as desired and click Create to save the trimmed copy.
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Printing PicturesPrinting Pictures
To print pictures on a printer connected to the computer, select the pictures 

and click the  (Print) button in the toolbar. The “Print” dialog will be displayed.

Adjust settings as described on the following page and click Print to print the 

picture as shown in the preview.

AA Notes on Printing Notes on Printing
Pictures can not be printed from the full-screen display.

To print to a JPEG fi le, click File Output….

The most recently-used settings are recalled when the print dialog is next displayed.

 The “Print” Dialog The “Print” Dialog

Print TypePrint Type

• Full Page: Print one picture per page.

• Index Print: Print multiple images per page (page page 4545).

• Standard Photo Sizes: Print pictures at a standard photo size. ViewNX 2 automatically 

chooses the number of pictures printed on each page.

Printer Setup
Printer Setup

PrinterPrinter Click Settings… to choose the printer and paper size and adjust other printer settings.

Printer TypePrinter Type Choose Inkjet when printing on an inkjet printer.

Print PriorityPrint Priority
When printing NEF/NRW (RAW) pictures, choose Speed to use the preview data embed-

ded in the image for faster printing, or Quality to use the original image data for higher 

quality ouput.

CopiesCopies Choose the number of copies of each page printed.

Page Layout
Page Layout

Rotate to fi tRotate to fi t Rotate pictures to print them at the largest possible size.

Crop images Crop images 
to fi tto fi t

Pictures are enlarged to fi ll the print area. Portions that do not fi t in the print area are 

cropped out.

Background Background 
ColorColor Choose the background color. Choose White to print with no background.

Border widthBorder width Choose the width of the borders printed around the image (the color of the borders var-

ies with the background color). Choose 0 to print without borders.

Copies of Copies of 
each imageeach image Choose the number of copies of each photo printed.

Print InformationPrint Information Print the fi le name, date of recording, or photo information under each picture (page page 4444).
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 Print Information Print Information
To choose the information printed under each picture, select Print Information 

in the “Print” dialog (page page 4343), click Settings…, and adjust the settings described 

on the following page.

DD Print Information Print Information
Print information is not rotated when Rotate to fi t is selected in the “Print” dialog. Metadata that 

does not fi t in the print area will be omitted.

Advanced Print Information SettingsAdvanced Print Information Settings

Date/Tim
e Shot

Date/Tim
e Shot

Date ShotDate Shot Print the date of recording in the position selected for Position.

Time ShotTime Shot Print the time of recording together with the date.

Font SettingsFont Settings Choose the font, style, point size, and color used to print the date/time stamp. The results 

can be previewed in the “Sample” area.

MetadataMetadata Choose the fi le and photo information printed with each picture. The font, style, and 

point size can be selected in the “Font Settings” area and previewed in the “Sample” area.

Header/Footer
Header/Footer

HeaderHeader Enter the text and choose the alignment for the header that will be printed at the top of 

each page.

PagePage
NumberNumber

Choose whether to print the page number and the total number of pages and select the 

position and alignment. The page number can be positioned at the page Top (in the 

header) or Bottom (in the footer).

FooterFooter Enter the text and choose the alignment for the footer that will be printed at the bottom 

of each page.

Font SettingsFont Settings Choose a font, style, and point size for the header, footer, and page number. The results 

can be previewed in the “Sample” area.
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 Index Prints Index Prints
To print multiple images per page, select Index Print for “Print As” in the “Print” 

dialog (page page 4343) and choose the number of pictures printed per page.

■ Standard
Choose the number of pictures per page from 

a list box. The size of the pictures is automati-

cally adjusted according to the option select-

ed.

A 2 × 4 layout

■ Image Size
Pictures are printed at the size entered for 

“Width” and “Height” (the minimum size is 

20.0  mm  × 20.0  mm and the maximum the 

same as the page size). The number of pic-

tures per page is automatically adjusted ac-

cording to the size selected.

Pictures printed at 50 mm × 50 mm

■ Column and Row
Choose the number of columns and rows 

printed per page (the minimum is 1 and the 

maximum 10). The size of the pictures is au-

tomatically adjusted according to the options 

selected.

A 3 × 3 layout



Contents Introduction Image Transfer Viewing Pictures Selecting Pictures Finding Pictures Retouching Pictures Printing Pictures Other FeaturesOther Features

ViewNX 2 Reference Manual 46

Web ServicesWeb Services
ViewNX 2 can be used to manage, share, and publish pictures on social net-

working sites such as Facebook, YouTube, and Nikon’s my Picturetown.

AA my Picturetown my Picturetown
For more information on Nikon’s my Picturetown Internet picture sharing and storage service, visit:

http://mypicturetown.comhttp://mypicturetown.com

Logging In in to my PicturetownLogging In in to my Picturetown
This section describes how to upload pictures to my Picturetown. If you do not 

have a my Picturetown account, visit http://www.mypicturetown.comhttp://www.mypicturetown.com to obtain 

an account before proceeding.

 1 Click the Login… button in the “my Picturetown” tab to open the “my Pic-

turetown Settings” dialog.

 2 Enter your e-mail ID and password.

A To skip Steps 2 and 3 in future, select Save Password and Automatically login when 

ViewNX 2 is launched.

 3 Select the size for pictures uploaded to my Picturetown and choose wheth-

er to use XMP/IPTC keywords embedded in the image data as my Picture-

town tags. To add all pictures with an XMP/IPTC rating to your my Picture-

town favorites, select Add XMP/IPTC rating as my Picturetown favorites.

 4 Click OK to log in to my Picturetown.

DD Uploading Pictures to my Picturetown Uploading Pictures to my Picturetown
An Internet connection is required. The following fi le types are supported: JPEG (RGB), NEF/NRW 

(RAW), and TIFF images and movies and audio fi les in MOV and AVI formats (note that my Picture-

town displays only the fi rst frame of movies uploaded to the site).
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Web Services 

Viewing PicturesViewing Pictures
Follow the steps below to view photographs and movies uploaded to my 

Picturetown.

 1 Click the Login… button in the “my Picturetown” tab and log in to my 

Picturetown.

A To skip this step in future, select Save Password and Automatically login when ViewNX 2 

is launched.

 2 Select an album in the “my Picturetown” 

tab, or select All Photos to view all up-

loaded pictures. To view pictures in all 

albums you have created, select My Al-

bums.

AA Sharing Albums Sharing Albums
To share photos with others, click the  (Web Services) button in the toolbar, select Share (my 

Picturetown)…, and enter the e-mail address of the people with whom you wish to share the 

pictures. To view albums others have shared with you, select Albums shared with Me in the “my 

Picturetown” tab.

Uploading PicturesUploading Pictures
Follow the steps below to upload pictures to my Picturetown.

 1 Select pictures.

A To select multiple images, drag to select the desired pictures in the thumbnail area or use 

the Shift or Ctrl (or in Mac OS, the /command) key. See page page 1717 for more information.

 2 Click the  (Web Services) button in the tool bar and select Upload to my 

Picturetown….

 3 An album selection dialog will be displayed. To upload pictures to a new 

album, select Create new album and enter the album name. To upload 

pictures to an existing album, select Use existing album and choose the 

desired album.

 4 Click OK to upload the pictures.
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GPSGPS
GPS data embedded in photographs (and in the case of some cameras, movies) 

can be used to create a map showing where the pictures were taken. Even if 

your camera does not support GPS, location data can be added to pictures by 

placing pins on the map in the locations the pictures were taken or by entering 

coordinates obtained from a third-party GPS unit.

To display the map, click the  (GeoTag) button in the toolbar. Pin icons ( ) 

indicate the locations where pictures were taken.

The GPS ToolbarThe GPS Toolbar

Add or edit location data for the current picture.

Edit heading information.

Show the straight-line path between locations.

Display the area shown on the map in a web browser.

Choose a map server and home location.

Reset the map to your home location.

Display GPS tracks.

Center the map on the currently selected location.
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Sending Pictures by E-MailSending Pictures by E-Mail
Pictures selected in ViewNX 2 can be appended to e-mail messages automati-

cally created in the default e-mail application for your operating system.

AA E-Mail Applications E-Mail Applications
The default e-mail application can be selected in the Internet Options control panel (Wiindows) 

or in the preferences dialog for the Mail application (Mac OS). ViewNX 2 is compatible with the ap-

plications listed below.

• Windows: Windows Live Mail, Windows Mail, Outlook Express, Outlook, Thunderbird 10

• Mac OS: Mail, Entourage 2008, Outlook for Mac 2011, Thunderbird 10

Sending Individual PicturesSending Individual Pictures
Send selected pictures as separate attachments.

 1 Select pictures.

A To select multiple images, drag to select the desired pictures in the thumbnail area or use 

the Shift or Ctrl (or in Mac OS, the /command) key. See page page 1717 for more information.

 2 Click the  (EMail) button in the tool bar to display the “EMail” dialog.

 3 Open the “Send as” menu and select Mul-

tiple photos (attachments).

 4 Choose a format and size for the attachments from the Image settings 

menu. To send the pictures at their original sizes and in their original for-

mats, including all metadata, choose Original; to send the pictures at their 

original size but convert the attachments to JPEG format, select JPEG (orig-

inal size). 

A The aspect ratio and orientation of the original images are maintained.

 5 Choose a compression ratio (image quality).

A Dragging the slider to the left reduces the size of the attachment but produces poorer-

quality images, while dragging the slider to the right results in improved image quality but 

also produces larger fi les.

 6 Click Send. The default e-mail application will launch and a new message 

will be opened with the selected pictures appended.

DD Sending Pictures by E-Mail Sending Pictures by E-Mail
Pictures are sent in JPEG format, regardless of the format of the original. The appended pictures are 

automatically converted to the sRGB color space; XMP/IPTC information and other metadata are 

not included.
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Sending Pictures by E-Mail

Sending an Index ImageSending an Index Image
Send multiple selected pictures as a single attachment.

 1 Select pictures.

A To select multiple images, drag to select the desired pictures in the thumbnail area or use 

the Shift or Ctrl (or in Mac OS, the /command) key. See page page 1717 for more information.

 2 Click the  (EMail) button in the tool bar to display the “EMail” dialog.

 3 Open the “Send as” menu and select One 

index print photo (single attachment).

 4 Choose the desired size.

 5 Choose a compression ratio (image quality).

A Dragging the slider to the left reduces the size of the attachment but produces poorer-

quality images, while dragging the slider to the right results in improved image quality but 

also produces larger fi les.

 6 Choose a layout.

A The layouts available depend on the option selected for Size.

 7 To display the fi le name under each picture, select Use name as title. Select  

a background color as desired.

 8 Click Send. The default e-mail application will launch and a new message 

will be opened with an index print of the selected pictures appended.


